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1.1 What is GEOPAK Drainage? 

GEOPAK Drainage is a comprehensive system for designing and analyzing storm drain systems, 
which can leverage many roadway design features to create a seamless information exchange to 
the drainage design process.  A GEOPAK Drainage project may contain multiple drainage 
networks; each comprised of any number of topologically connected drainage areas, inlets, pipes 
and ditches.  The GEOPAK Drainage workflow closely mirrors conventional design processes 
allowing for the design of the surface collection system (i.e. drainage areas, inlets) then the 
design of the subsequent conveyance system. 
 
GEOPAK Drainage is extremely flexible, in that the hydraulics designer can create and 
manipulate elements of the system, while simultaneously seeing the effects.  Interactive dialogs 
and design visualization make the process easy to learn and efficiently produce results.  
Manipulations and redesign are accomplished quickly and easily, whether it's moving a single 
inlet or developing an entire network.  At any time during the process, customized reports can be 
generated to provide hard copy outputs.  
 
Roadway alignments, vertical profile gradelines, and digital terrain models created as part of the 
design process may be used throughout GEOPAK Drainage to provide pertinent information to 
drainage design.  All drainage components feature interactive graphical placement tools for easy 
spatial definition of the drainage system. Visualization tools in GEOPAK Drainage for networks, 
drainage components, and computations all but eliminate the tedium of thumbing through pages 
of computer output to evaluate whether the system is functioning adequately.  The visualization 
allows for immediate evaluation of the drainage system. 
 
GEOPAK Drainage hydrologic and hydraulic capabilities include runoff computations, inlet 
design and analysis, and pipe and ditch design and analysis.  All computations follow 
recommended methodologies in the FHWA publication “Drainage of Highway Pavements” as 
well as the procedures in the AASHTO Model Drainage Manual. 
 
Runoff computations are performed using either the Rational or SCS method where rainfall 
parameters may be specified with common intensity equations, hydrographs, or by tabular 
intensity-duration data.  Drainage area delineation tools allow easy creation of contributing areas 
and the graphical assignment of these to drainage features.  The extremely tedious task of 
compiling different subareas and runoff coefficients is practically eliminated by GEOPAK 
Drainage’s graphical shape tool, allowing easy creation of drainage areas and land use 
boundaries.  Once the boundaries are defined, the runoff coefficient and associated hydrologic 
parameters are computed automatically by delineating the land use zones inside of the drainage 
area.  Any subsequent modifications to the boundaries will update the runoff coefficient via a 
single mouse click. 
 

For GEOPAK Drainage support, please contact the CADD Support Center. 
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1.2 Objectives 

• Understand the components of GEOPAK Drainage 
• Understand the contents of the Drainage Library 
• Learn how to set Project Preferences 
 
 
 

1.3 Project Workflow 
 
The GEOPAK Drainage workflow mirrors the conventional design process beginning with the 
design of the surface collection system (inlets, drainage areas) followed by the design of the 
conveyance system (subsurface pipes, channels). 
 
Roadway alignments, vertical profile gradelines and digital terrain models may be used 
throughout GEOPAK Drainage to provide pertinent information to the drainage design.  All 
drainage components feature interactive graphical placement tools for easy definition of the 
drainage system. 
Each of these components (inlets, areas, pipes, and other objects) are composed of two basic 
types of information: 
 

Spatial information describing its location, shape and connectivity. 
 

Hydraulic and hydrologic information describing its properties, conventions and other 
associated attributes. 
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1.4 Components 
GEOPAK Drainage organizes the components of a drainage system according to their spatial 
characteristics.  Spatial information is stored as Nodes, Links and Networks. 
 

Nodes:    A node (inlets, manholes, etc.) is a point with a user-defined location.  The 
location may be in Cartesian coordinates (x,y) or in curvilinear coordinates (station, offset).  
Nodes are used to model: 
 

• Inlets (curb inlets, grate inlets, slotted drains) 
• Junctions (manholes, grade breaks, bends) 
• Outlets 
• Others (user-defined) 

 
Links:   A Link represents a linear feature depicting a path connecting two nodes, traversing 
upstream to downstream.  The path may be straight line or curvilinear (along a graphic 
element).  Links are used to represent: 
 

• Pipes (over +1,000 default pipes) 
• Ditches (any shape – including automatic design capabilities) 
• Channels (cross section based utilizing TIN files) 

 
Networks:   A network is a series of interconnected nodes and links that form a system 
through which water can flow to a single outlet node. A single project accommodates any 
number of Networks of varying types. 
 

Other associated components in GEOPAK Drainage include: 
 
Areas:   A drainage area can be represented by a closed boundary or simply keyed-in (acres 
or hectares). All flows from a single drainage area are tributary to a single Node.  Thus, 
there is a one to one correspondence between a node and an area.  Therefore areas and nodes 
share the same name (ID). A drainage area may contain multiple subareas representing 
homogeneous features such as soil types and land uses (“C” values), thereby allowing 
composite "C" value calculations. 
 
Profiles (Hydraulic):    A profile represents a path connecting any two nodes in a Network. 
Profiles provide the visualization of profiles between any two nodes in a drainage network. 
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1.5 Invoking GEOPAK Drainage 
GEOPAK Drainage is part of the GEOPAK suite of civil tools and needs to run within the 
MicroStation environment.  Follow the steps listed to access GEOPAK Drainage. 

 
1. Launch ProjectWise Explorer and navigate to the following location: 

 
District CADD\ Design\Cole#\J5EX501\Data 

 
2. Find the following file and open it with MicroStation: 

 
plan_J5EX501.dgn 

 
3. From the Applications pull-down menu choose GEOPAK > Drainage 

 

 
 
Once activated, a separate menu for Drainage will show up next to the Applications menu.  All 
items in Drainage can be accessed through this main Drainage pull-down menu. You can also 
use the Drainage Tool Box by choosing the Main option under the Tool Boxes menu or use the 
Drainage menu bar which is displayed whenever Drainage is active: 
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Every time GEOPAK Drainage is activated it opens as an untitled project and is set to use the 
Bentley default preferences.  In order to have the correct default MoDOT preferences you will 
want to change this by using one of the procedures outlined below. 
 

 

 
Once you have done either of these processes the banner for your Drainage menu bar and the 
MicroStation window should display your drainage project name. 
 
 

Beginning a New Drainage Project -  When you are starting a new project and have 
activated GEOPAK Drainage for the first time on that project: 

1. Click the Project pull-down menu on the Drainage menu bar and select the Preferences 
option 

2. Click the File pull-down menu on the Preferences dialog box and select the Open 
option 
- The Open Drainage Preferences dialog should pop up and the folder location 

should be set to your project data folder 
3. Select MoDOT_Drainage.dpf from the list of available files and click the Open button 

in the lower right corner of the Open Drainage Preferences dialog box 
- The MoDOT_Drainage.dpf file simply changes all of the variables in the Drainage 

Preferences to reflect the suggested MoDOT settings 
4. Click the OK button on the Preferences dialog box to apply the new preference 

settings to your drainage project 
- You will be prompted to save your drainage project at this point 
- This must be done before you can change preference settings  

5. Choose the No Wizard option and click OK 
6. In the Document section of the Save Drainage File dialog box change the Name and 

the File Name to the name you would like to use for your drainage project file 
- The system automatically fills in these fields using the name of the DGN file you 

are currently working in and giving it a GDF extension 
- The name you use much match in both the Name and the File Name fields 
- It is not necessary to change the Description but it can be helpful later on if the 

project is large and might require the use of more than one GDF file  
7. Click the Save button on the Save Drainage File dialog box 
8. Click the Yes button when the system prompts you to store the preference changes 
9. Now you can open the Preferences again and make any changes necessary for your 

project situation then click OK to apply to your GDF 

Opening an Existing Drainage Project -  The GDF file stores the preferences that were 
assigned at the time the project was last saved and so if you have an existing project then you 
simply need to open your GDF file to restore your preferences and settings: 

1. Click the Project pull-down menu on the Drainage menu bar and select the Open 
option 

2. Select your existing GDF file from the list and click the Open button in the lower right 
corner of the Open Drainage File dialog box 
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4. Follow the instructions provided on the previous page for beginning a new 

drainage project. 
- For step 4 we will make changes to the Preferences as we progress through 

the following pages and review the different options 
- When you reach step 6 in the instructions use the following name for your 

file: 
 

drainage_J5EX501.gdf 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A little information about the GEOPAK Drainage File (GDF): 
 
The GEOPAK Drainage File or GDF stores the drainage project data in much the same way 
that the GPK file stores the data for GEOPAK Road.   
 
A single GDF file can be used to store data for multiple networks (individual drainage 
systems).  However, the GDF file format can become corrupted if pushed too far and it is 
recommended that if networks are large/complex that each network should be stored in a 
separate GDF file. 
 
The GDF file can be corrupted if more than one user accesses it at one time, so the GDF file 
should be stored in ProjectWise and not on the T: drive.  
 
As mentioned in the instructions given for opening an existing drainage project, the GDF file 
stores the preferences that are assigned when the project is saved and those preference settings 
will be restored when the GDF file is opened for use. 
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1.6 Review Project Preferences 
The Project Preferences control the graphic and computational options of the drainage system. 
Each category of options contains variables that are set to MoDOT suggested standard settings.  
These settings can be manipulated by the user if needed during the design process. 
 

1. Click the Project drop-down menu and select Preferences. 
 
 

 
 

Units 
This option defines what system of measure the project will use when performing calculations 
and generating output.  It also provides the user with information about what units of measure 
are being used for specific input and output fields. 

 
English   

 

 
 

 
 

For each of the Options on the Preferences dialog box we will be changing the 
settings to fit our project needs.  The values we will be using are highlighted.  
Please make sure your preferences are set up in a similar manner. 
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Project Components 

 
 

Drainage Library File (DLB):  T:\Gpk_std\Drainage\dote.dlb 
 
GPK Job Number: job###.gpk  (GPK file for the job you are currently working on) 

 
Drainage Cell Library:  T:\Gpk_std\Drainage\drainage.cel 
 
Criteria Directory:  MoDOT does not use criteria for Drainage. 
 
DDB:  MoDOT does not link Drainage to the GEOPAK D&C manager database at this time. 
 
Water and Sewer Project:  MoDOT does not use Water and Sewer projects. 
 
 
 
 

When setting up the preferences for the first time on a Drainage project the user needs 
to set the path to the GPK:   

1. Click the User Preferences button to the right of the magnifying glass 
2. Click COGO Preferences button on the User Preferences dialog box 
3. Set Job (GPK) Directory to the correct T: drive data folder for the current job  
4. Click OK for the COGO Preferences and again for the User Preferences 
5. Once this path is established the user can click the magnifying glass button and 

select the correct GPK file from the list. 
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Supereleveation Shapes File:  This field can be pointed to the superelevation shapes file (DGN) 
allowing Drainage to read elevations, cross slopes, and grades for jobs with roadway sections 
that are superelevated 
The superelevation shapes file must also be referenced into the DGN file you are using for your 
drainage project 
 
Site Project:  This field can be pointed to the GEOPAK Site File (GSF) for a Site project 
allowing Drainage to use data from a Site model or object 
 
Original Ground:  MoDOT does not typically assign an original ground surface 
 
Design Surface:  User can assign a final design (proposed) TIN file that will allow Drainage to 
read and use surface elevations when working with components 
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Rainfall Parameters  
The rainfall Parameters option is used to select the intensity equation to be utilized on the final 
project.  Both the Rational Method and the SCS Methods are available. 
 
Section 749.4 of the EPG states that the Rational Method should be used on all watersheds less 
than 200 acres in size.  For further guidance please refer to Category 749 of the EPG.  
 
Select District 5 as the Rainfall Source under the Rational Method.   
 

 
 
Rational Method Rainfall Source: The Rainfall Data Source for computing intensities and 
discharges, which is stored within the Drainage Library File, therefore it may only be selected 
here.   
 
SCS Method: Rainfall Source is the data source for computing discharges, which is stored 
within the Drainage Library File - therefore, it may only be selected here.  The Antecedent 
Moisture Condition I is the lowest runoff potential (dry soil), while Antecedent Moisture 
Condition II is the average condition, and Antecedent Moisture Condition III is the highest 
runoff potential (saturated soil).  
  
Hydrograph Time Interval: Specified in terms of minutes. 
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Land Use Options 
The Land Use dialog establishes the land use options used to delineate sub-areas and runoff 
coefficients for the current project.  When selected from the Options list, the dialog depicted 
above is displayed. 
 

 
 
Single Land Use Item The land use source from the Drainage Library containing the runoff 
coefficients and symbology for land use delineation may be selected from the list box. 
 
Select Single Land Use Item and make sure MoDot is set in the list box 

- This will allow you to choose from all the predefined land use types and their 
corresponding C values contained in the MoDOT library when assigning land uses. 

 
Multiple Land Use Item Allows the use of multiple categories if available in the specified 
Drainage Library.  To select, utilize the down arrow in the list box and select the desired option.  
The item selected must be associated with a symbology that matches the symbology of each of 
the main land use shapes in the design file.  Our library does not contain multiple categories, 
so this option is not used at MoDOT.  



Chapter 1 Introduction 

10/18/12 Missouri Department of Transportation 1-13 

Frequency Options 
 
The Frequency Options dialog establishes the computation frequency and runoff peaking factors 
for discharge computations for the current project.   
 

 
 
Drainage Library File (DLB)  The current Library File as specified in the Project Component 
option is displayed.  It cannot be changed from this dialog, only in the Project Components. 
 
Computation Frequency  The displayed frequencies are selected from the available entries in 
the Rainfall Parameters chosen from the library. 
  
Cumulative Frequency  The displayed depths are selected from the available entries in the 
Rainfall Parameters chosen from the library.   
 
Peaking Factors  These factors are used to adjust runoff coefficients for  frequencies other than 
the 5-year or 10-year options.  The frequency correction factor is 1.10 for the 25-year event, 1.20 
for the 50-year event, and 1.25 for the 100-year event. However, the resulting runoff coefficient 
(original "C" multiplied by the frequency correction factor) may not be greater than 1.0  (EPG 
749.5.2.3). 
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Intensity Options    

 
 

Minimum Time of Concentration: 5.0000  
The Minimum Time of Concentration is used for all drainage area computations and pipe travel 
time in discharge computations and is used throughout these computations as the minimum. In 
pipe hydraulic computations this value will be used until the actual time of concentration within 
the systems exceeds this value. Specified in terms of minutes. 
See EPG Section 749.5.3 for Time of Concentration information. 
 
Accumulate Pipe Flow Time by:  Uniform Flow Velocity 
The Accumulate Pipe Flow options adjust the travel time through the pipe. Options include 
Uniform Flow Velocity (uses velocity associated with normal depth to establish travel time), Full 
Flow Velocity (uses velocity associated with full flow [V=Q/A] to establish travel time) , and 
Iterative Velocity (GEOPAK analyzes the network under three iterations, so velocity and travel 
time closely match actual flow conditions). 
 
Intensity Options  Compute Intensity from Library Rainfall Data Source 
The Weight Time of Concentration is used when combining different types and times of 
concentration, activating this toggle weights the times of concentration such that the discharge 
will not decrease.   
 
Inlet Computation Only The Absolute Intensity provides a constant intensity that overrides the 
Drainage Library File and utilizes the specified value for discharge computations required for 
inlet and spread calculations only. Network hydrologic discharges will be computed as specified 
in the Intensity Options. Note, however, for the value to be utilized, the toggle to the left of the 
Absolute Intensity within the Inlet Computation Only box must be activated or the value will 
be ignored. Specified in terms of in/hr or mm/hr depending on the project units. 
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Junction Losses Options 
 AASHTO default coefficients and Method 2 are used to compute junction losses. 
 

 
 
Disable All Junction Loss Computations 
If the toggle is active, no Junction Loss computations are calculated.  
 
Note:  If a single or small number of Junction Losses are not desired, an option is provided later 
in the design to accomplish this. The toggle here applies to the entire project. 
 
Loss Velocity 
Losses can be computed on Actual or Full Flow. 
 
Pressure Expansion 
Loss coefficient to be used in pressure (full flow) expansions within the system. 
 
Free Surface Expansion 
Loss coefficient to be used in free surface (partial flow) expansions within the system. 
 
Pressure Contraction 
Loss coefficient to be used in pressure (full flow) contractions within the system 
 
Free Surface Contraction 
Loss coefficient to be used in free surface (partial flow) contractions within the system. 
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Bend Loss 
Specify the methodology and source of bend loss computations.  

• Method 1 utilizes Modern Sewer Design, while Method 2 utilizes AASHTO methods. 
 
Terminal Inlet / Junction 
Loss coefficient to be used at terminal inlets or junctions (no upstream pipes) within the system. 
 
Simple Junction 
Specify the methodology for computing junction losses at simple junction (one pipe into the 
junction and one pipe out).    

• Method 1 utilizes Modern Sewer Design, while Method 2 utilizes AASHTO methods. 
 
Complex Junction 
Specify the methodology for computing junction losses at complex junctions (more than one 
pipe in and only one pipe out).  

• Method 1 utilizes Modern Sewer Design, while Method 2 utilizes AASHTO methods. 
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Inlet Options 
The Inlet Options establish the default inlet variables to use in the Node Configuration Properties 
for each type of inlet. 
 

 
 

Inlet By Pass Options:  By Pass as Total Discharge  
This option indicates the method by which Inlet by pass flows are accounted for in the system. By 
Pass as Total Discharge will account for by pass flows as the difference between the total 
discharge to the inlet and the inlet capacity. This difference, expressed in flow units, will be the total 
by pass from the inlet and can be added at a subsequent downstream inlet. By Pass as C x Area 
Product, on the other hand, is determined from the total bypass at the inlet as a product of runoff 
coefficient and drainage area that is contributing to the total bypass at the inlets computed intensity. 
This product of area and runoff coefficient will then be added to the composite runoff coefficient and 
area at the  downstream inlet. 

 
Link By Pass Flow Options:   Do Not Allow Inlet By Pass in Link Discharges  

This option indicates the method by which Inlet By Pass flows are accounted in the Link discharge 
computations. Do Not Allow Inlet By Pass in Link Discharges will prevent the system from 
bypassing discharges from one inlet to the next when Link discharges are computed. The total 
discharge that reaches the inlet will be considered entering the Link at that point. This option in no 
way impacts the inlet computations, bypass flows will be reflected in these computations. Allow 
Inlet By Pass in Link Discharges will account for the discharge that bypasses the inlets when the 
Link discharges are computed. Only the discharge entering the inlet will be considered entering the 
Link at that location. Bypass flows will be directed to the appropriate inlet and the Link accordingly. 
 

Default Spread N Value:  0.016  
The default Manning's roughness coefficient for the spread hydraulic computations. 
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Node Options 
Select the node-link graphical interface and node naming convention. 
 

 
  
Default Node ID Prefix:  CB – 
 All nodes will be identified as CB-# where # starts at 1and is numerically sequenced by 1 as 
additional nodes are added to the system. (Drainage Areas share the same ID’s as Nodes.)  Feel 
free to change the prefix.  For large projects it may be beneficial to break up the project into 
different series: (A1, A2, …An) , (B1, B2, …Bn), etc. 
 
Scale Node Cells should be toggled off.  We design projects on a one to one scale. If it is on, just 
make sure it is at a Scale Factor of 1.0000 
 
Minimum Freeboard:  1.0000 (see EPG Sec 750.4.4.7)  
This option is used to maintain a certain amount of free space in the node from top of water 
surface to top of inlet.  GEOPAK measures freeboard from the hydraulic grade line to inlet 
elevation. 
Note:  This option does not affect computations in any way.  It is only used to trigger a warning 
(HGL Blowout) if the hydraulic grade line forces less than minimum freeboard. 
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Link Options 
Set the preferred design options for the design of the conveyance system. 
 

 
 

Default Link ID Prefix:  SS – 
All links will be identified as SS-# and start at 1 and numerically sequenced by 1 as additional 
links are added to the system.  Feel free to change the prefix.  
  
Design Optimization considers the pipe profile envelope created when nodes and links are 
placed and a minimum soffit and maximum invert are established. 
Minimize Pipe Size uses the entire envelope to size pipes and will choose smaller pipe sizes 
with steeper slopes if possible.  If the entire envelope does not result in a smaller pipe then the 
appropriate size pipe will be selected based on the top of the envelope. 
Minimize Depth of Cover bases pipe sizing on the top of the envelope maintaining a 
minimum soffit elevation. 
       
Elevation Option is used to establish the elevation that is reported for the ends of each link 
when a profile is generated.  Hydraulic Center reports the elevation at the center of the node 
structure and Actual End reports the elevation at the actual end of each pipe. 
 
Link Design Options:  Design for Full Capacity is the preferred option and uses 100% flow 
to design the pipe size for capacity greater than the discharge. 
Note:  In comparison Design for Maximum Capacity assumes approximately 90% flow. 
 
Hydraulic Gradeline Basis:  Equal Hydraulic Gradeline is preferred and assumes that the 
starting lower end HGL of a link is equal to the upper end HGL of the downstream link. 
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Profile Options 
GEOPAK Drainage allows users to store chains (hydraulic) and profiles (hydraulic) in COGO.   
 

 
 
 
Default Profile ID Prefix:  PR – 
This prefix is added to the beginning of the each defined profile automatically and then 
numerically sequenced by one. For example, the first Profile stored would obtain default ID in 
this case of "PR–1" followed by "PR–2", "PR–3", etc. for subsequent Profiles.  If the links are to 
be used for COGO chains or profiles, the length of this prefix should be within the parameters 
for chain and profile character limitations. 
 
Create COGO Chains and Profiles 
When toggled on, the links are stored in the coordinate geometry database (GPK) specified in the 
Project Components.  The link name is used as both the chain and profile name.  Stationing 
starts at 0+00. 
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Plan Symbology 
The defined symbology is set to reflect the MoDOT CADD Standards.  This symbology may be 
revised or manipulated at any time.  To change the symbology for any item simply double-click 
that item and make the desired revision. 

Updates 
Choose to Automatically update the components in the current drainage file as changes are made 
to the system. 
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Save Options 
Choose whether to Automatically save all drainage updates, save a backup or save at give 
intervals of time   
 

 
 

 
Automatically Save Drainage Updates When activated, the Drainage project file (.gdf) is saved 
every time an Apply command is issued from any Drainage dialog. 
 
Automatic Backup When activated, a backup file is always created (in the project directory 
with a *.bak extension) when the project is opened. 
 
Because of the corruption issues that we deal with from time to time on the GDF files, it is 
recommended that you enable the Automatic Backup option. 
 
Automatic Save To automatically save, activate the toggle to the left of the option, then select 
the desired time interval. 
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Drainage Preferences may be changed at any time and the system can then be redesigned or 
analyzed utilizing the new settings. 
 
There are times when you might want to set up different scenarios using different preference 
settings to see how a drainage system will act under different conditions.  Preferences can be 
saved by going to the File pull-down menu on the Preferences dialog box and choosing the Save 
As option and saving the current preference settings as a new DPF (Drainage Preference File).  
These preferences can then be recalled anytime they’re needed by using the Open option under 
the File pull-down menu. 
 

 
 

 
 
 
 

2. Click the OK button on the Preferences dialog box to enable the current 
settings and close the dialog. 
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1.7 Review Drainage Library 
 
The Drainage Library is used to store data and standards that may be shared by different projects 
and designers.  MoDOT supports one main library (dote.dlb).   A metric library is also 
available as well as custom libraries if needed.  These libraries are maintained at CADD Support, 
and should not be modified. 
  
 

1. Click the Project drop-down menu and select Drainage Library. 
  
 

 
 
When the Drainage Library dialog comes up, make sure the banner displays the path as 
T:\Gpk_Std\Drainage\dote.dlb 
  
Note the first four tabs in the Drainage Library: 
  

• Rainfall: Contains the Rainfall Data Sources 
• Land Uses: Contains the specific Land Uses and their corresponding “C” value 
• Nodes:  Inlets, Junctions, Manholes, Outlets, etc. 
• Links:  Circular Pipes, Elliptical Pipes, Pipe-Arch pipes, Boxes, etc. 
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Rainfall Tab 
 
Rainfall Items store all the rainfall data information to be used on GEOPAK Drainage Projects.  
GEOPAK Drainage supports rainfall sources in the form of intensity duration frequency (IDF) 
tables, or as coefficients for intensity-duration-equation formats.  Also supported are the SCS, 
HYDRO-35 and TP 40 methods of rainfall. 
 
This is the same information used to develop our IDF curves for each District.  See the EPG 
749.5.4. 
 

   
 

  

 

Modify 

To explore the data highlight any rainfall item, then right-click and select Modify.  Or select 
the modify button on the right.  Take a look at the defined information. 
When you are finished reviewing the information select the Cancel button to exit the 
Rainfall Data Source Item dialog. 
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Land Use Tab 
 
Land Uses are used to store runoff coefficients ("C" values) and corresponding symbology for 
each land use.  The runoff coefficients are divided up into two groups: Rural and Urban.  The  
rural coefficients are based on the topology and soil classification while the urban coefficients 
are defined based on the land use.  See the EPG 749.5.2. 
 
 Land Uses can be automatically delineated with GEOPAK Drainage.  The DGN file is scanned 
for the land use symbology from the Drainage Library and associates the symbology, as well as 
the graphical shape, with the "C" value as set in the library. The “C” values are then weighted 
according to their ratio of land area within the main area delineation, and a properly weighted 
“C” value is calculated for the land area under consideration.  Alternately, the land uses can be 
put into the project manually. 
 

.   
 

           

 

To explore, highlight the MoDOT item, right-click and choose Modify 
When done select Cancel. 
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Nodes Tab 
 
Nodes contain standard configurations for Grates, Curbs and Slotted Drain inlets, as well as 
Junctions, Outlets and Other Nodes.  The description, plan view representation and dimensional 
information for each Node item is entered only once in the Drainage Library and then referenced 
by each project. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Choose the Grate option from Node Types, then select the first node and Modify. 
You can review the cell information by pressing the Select button to the right of the Plan 
View Cell field.   
When complete, close both the cell selector and the node item by choosing Cancel.  
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Links Tab 
 
The Links are categorized by three properties for each pipe: Shape, Material, and Type 
(corrugation).  Each pipe resides in its own dialog box that contains the specific pipe geometry, 
default roughness coefficient and material combination. 
 

 
                   

 
 
 
 
 

 
 
 

To explore the type of data common to the links, set the Shape to Circular, the Material to 
Concrete.  Highlight the first pipe, then choose Modify.  
When done select Cancel.  
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Spread Section Tab 
 
The Spread Section tab is used to set up roadway section spread situations.  MoDOT has not 
developed library items for this option.   
 
More information will be given when setting Spread Criteria in the Node Configuration (Inlets) 
section of the class. 

 
 
 
 
 

2. Exit out of the Drainage Library. 
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2.1 Objectives 

 

2.2 Overview 
The term drainage area refers to a total extent of land that collects surface water and funnels 
that water to a low point that immediately impacts a roadway project.  A drainage area can have 
just one land use type or might be made up of multiple land use types.  A drainage area’s land 
use types need to be defined in order to get the correct runoff value. 
 
The land use types of a drainage area are determined by their surface type and functional use.  
These two factors are used to determine the amount of rain water that will be absorbed, how 
much will run off, and how quickly it will run off during a storm event. 
 
For more information on drainage areas and land uses see Category 749 
 
Establish land uses in the watershed which include an apartment complex, a park, and pavement 
as well as an area of undefined land use.  All water drains to the gutter at the edge of the paved 
road and then to the downstream end of the watershed.   The dimensions for the various land 
uses and the overall drainage area are given below.  Assume a time of concentration of 10 
minutes. 
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Introduce the designer to Drainage Areas and Land Uses in Geopak Drainage 
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2.3 Basic Layout 
Using the steps given below, draw Microstation shapes representing the overall drainage area 
and the areas that represent the individual land use types shown in the diagram above. 
 

1. Make sure AccuDraw is activated 
 

2. Select the Place Block tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Data point at the location that will represent the bottom left corner of your 
drainage area 
 

4. Move the mouse to the right (X direction) type in 150 to lock distance into 
AccuDraw 
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5. Now move the mouse up (Y direction) and type in 300 to lock in this distance, 

and hit Enter on the keyboard 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Based on the supplied dimensions complete the areas that represent the 
apartments, park, undefined area, and road.   

 
 
 
When finished, you should have drawn a total of 5 rectangles, 1 for the overall drainage area 4 
more for each land use type inside the overall drainage area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
You should now have the rectangle that forms the outside perimeter of the entire drainage area. 
 
Now we can establish the land use areas that will provide runoff to our project. 
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2.4 Define Landuses 

1.   From the Geopak Drainage file menu go to Component >Landuses 
 
2.   For the lower left hand area select Parks\Cemeteries 

• Click the Select Shape button 
• Data point the edge of the lower left hand area to select the shape 
• Data point a second time to accept the selection.  The area should change to 

the assigned color in the drainage library (In this case dark blue) 
 

 
 
 

3.   Based on the supplied descriptions assign the remaining land uses.  When finished 
you should have 3 assigned land uses. 
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2.5 Define Drainage Areas  

1.   Go to Component >Area >Add 
• Notice the Drainage Area ID defaults to CB – 1.  For this example change the 

ID to Total   
• In the Area Definition region click the Select Shape button 
• Data point on the rectangle that represents the entire drainage area 
• Data point a second time to accept the selection (The drainage area field 

should now contain the area in acres) 
 

 

 
 
 

2.    Enter in the time of concentration (Tc) as 10.000   
If the time of concentration entered is below the minimum Tc set in the preferences, the 
program will default to the minimum to compute the peak discharge for the area. 

 
3.    Enter in the base C value as 0.6   

Any areas that do not have a land use associated with them will be assigned the base C 
value.  In this example the area between the (Apartments – Park) and (Road) will be 
assigned a C value based of 0.6. 
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4.    Select the Subareas option on the left side 
 
5.    Select the Automation Delineation button.  

This will compute the area for any shapes with an assigned land use.  Notice how the 
subareas are temporarily filled in the with the assigned land use color. (You may need to 
go to >Settings >View Attributes in the Microstation menu and toggle on Fill) 

 
Also note that you could override the default C value for any land use by highlighting 
the row and selecting the modify button to the right of the screen.  
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6.    Select the Computation option 

Notice that the remainder is the area of any regions that do not have an assigned land 
use. 
 

7.    Click the Compute Discharge button 
 
Check the Composite C, Intensity, Total Area, and Discharge computed by Geopak. 
 

 
 
 

8.    Select the Apply button to add the Drainage Area ID to the drainage area  
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3.1 Objectives 
Create and place stormwater inlets and associated drainage areas in GEOPAK Drainage 

3.2 Overview 
Establish inlets to collect run off from the drainage area that we created in Chapter 2.  We will 
need to place 2 inlets in order to satisfy the ponded width (spread), ponded depth, and 
interception criteria.  If we recall from Chapter 1 that there must be a 1 to 1 relationship between 
inlets and drainage areas, so the overall drainage area will have to be subdivided and each of 
these subareas will be associated with an individual inlet.  
 
The first inlet (CB–1) is a 2’x2’ curved vane grate and will be located 80 feet from the 
downstream end of the drainage area.  The second inlet (CB–2) is a 2’x2’ combo curved vane 
grate and curb opening and will be located at the downstream end of the drainage area.  The 
typical spread section and vertical alignment of the roadway are shown in the figures on the next 
page. 
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Inlet Label Inlet Type Tc (min) Elevation (ft) 
CB-1 2x2 CV Grate on Grade 5 100 
CB-2 2x2 Combo CV Grate 6 99.5 

 
 
 
 

Typical Spread Section 
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Vertical Alignment 
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3.3 Define Subareas 

1. Create MicroStation shapes for subareas CB-1 and CB-2 as defined in the 
illustration in 3-1.  Area CB-1 is 150 ft wide and 220 ft long and area CB-2 is 150 ft 
wide and 80 ft long.  

 
2. Use the Drainage menu Component >Area >Add option to add each of the two 

drainage areas.  Be sure to add the Base C Value and Time of Concentration for 
each drainage area and use the Delineate Subareas button to include the land uses 
previously defined.  The Time of Concentration for CB-1 should be set to 5.0 and 
set to 6.0 for CB-2. 

 
Make sure that you click the Apply button when you complete your inputs for both drainage 
areas to store the values. 
 
Base C Value  The runoff coefficient (C value) for the drainage area.  If subareas are to be 
delineated within the Area, this value will be applied to all subareas which have no associated 
land use. 
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3.4 Define an inlet on grade 

1. Go to Component >Node >Add .  The node ID should appear as CB –1.   
This is important to note because drainage areas and inlets are associated by name only.  
In other words, the discharge from drainage area CB-1 will flow into inlet CB-1.  
Because of this you may want to give inlet CB-1 a description like “Inlet for sub-area 1”. 

 

 
 
Use the following information to create CB-1 
 
Properties Option 
 
Node Type:  Grate  
 
Profile:  On Grade (Note that the hydraulic computations are different for inlets on grade and 
inlets at sags so it is important to select the proper profile.) 
 
Library Item:  Select GRATE CV 2x2 for a 2’ x 2’ Curved Vane Grate 
 
By Pass to Node allows us to identify the downstream inlet that will collect any runoff that is not 
caught at CB-1.  This can be accomplished by selecting the ID button and then selecting either 
the label or cell for the downstream inlet.  Alternately we can type in the node ID.  We will 
complete this step after placing CB-2. 
 
Max By Pass does not enter into any hydraulic computations, and is just used for querying the 
system.  This will be discussed later in the course. 
 
Node Bottom won’t be used at this time.  
  
Override Library Payitem enables the user to select an inlet item other than the one specified 
from the defined drainage library.  We will not use this option. 
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Spread Criteria Options 
 
Longitudinal Slope Source:  This is the actual grade along the vertical curve and not 
necessarily the tangent grade G1 or G2.  For this example set the option to User Supplied and 
enter 0.7 
 
Spread Source:  Enter the cross section of the roadway beginning at the curb face and working 
towards the crown of the roadway.  For this example set the option to User Supplied 
 
Max Ponded Depth is the maximum depth of water that can pond at the inlet.  The ponded 
depth does not affect inlets at grade but does enter into the calculations for inlets at sags.  Since 
we are using a 6” curb height, the maximum ponded depth is 0.4 ft.   
 
Max Ponded Width is how much water will pond on the spread cross-section measured from 
the curb face.  For this example enter 10 ft. 

 

 
 

  



Chapter 3 Inlets 

3-8 Missouri Department of Transportation 10/18/12 

 
Elevations Options 
 
Elevation Source: User Supplied - 100 
 
Node Elevation Option: Same as Source 
 
The next 3 settings deal with establishing pipe elevations 
 
Vertical Alignment Preference: Match Soffit (top inside surface of the pipe) 
 
Minimum Depth for this example is 3 ft.  This is the upper limits of the design envelope, the 
soffit of the pipe cannot be placed above this line. 
 
Maximum Depth for this example is 12 ft.  This is the lower limit of the design envelope; the 
invert of the pipe cannot be placed below this line. 
 
The design envelope created by the Minimum and Maximum Depth values are used by 
GEOPAK Drainage to set the absolute top and absolute bottom elevations for pipes to enter and 
exit the node.  Additional information provided in the Chapter 3 Reference material.  
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Junction Loss Options 
 
Select Defined Equations  
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Discharge Options  
 
Use Computed Discharge will associate drainage area CB-1 to inlet CB-1.  Alternately you can 
specify a discharge. 
Disable Inlet Calculations Capacity: When this toggle is not active, GEOPAK utilizes the inlet 
capacity calculations. To override these calculations, the user may activate the toggle and 
provide the desired capacity.   
Link Base Flow Area/Discharge: When not activated, the drainage area identified for the node 
is utilized for calculations.  When this toggle is activated, additional drainage areas may be 
defined.  The area can be identified graphically by pressing the ID button and selecting the 
MicroStation shape or may be manually entered in the key-in field.  Note the area is included in 
the pipe, but is not included in the inlet spread calculations.  
A discharge amount may be specified as well by choosing that option from the drop-down box 
and inputing 
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Location Options 
 
We are not utilizing data from Geopak Road in this example. 
 

1. Set the Align setting to  Tangent to Element 
 

2. Select the MS Alignment Element button 
 

3. Data point on the rectangle that represents the roadway. 
 

Make sure AccuDraw is running 
 

4. Select the Station DP button and snap (single middle mouse click) to the lower 
right hand corner of the roadway.  Do not left-click to accept the snap! 
 

5. Select the letter  O on the keyboard to set the origin. 
 

6. Move the mouse in the negative X direction, enter 18.5  
(20’ pavement width, then subtract 6” curb and ½ the grate width) 
 

7. Move the mouse in the positive Y direction, enter 80, and data point to accept. 
 

8. Finally select the Apply button.  
 
 The inlet is now saved to the *.gdf file, any changes to the inlet will now be updates. 

 
 

 
 

 
 

MS Alignment Element 

      Station DP 
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After you are finished CB-1 should appear in this location: 
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Computations Options 
 
The Computations Option will show all the information pertaining to the new inlet based on the 
area associated with it.   
 
In this example we can see that the Spread Width is 9.2631, which is less than the 10’ that was 
allowed.  The ponded depth is .3353, which is less than the .4’ that was allowed.  There is some 
bypass flow indicating that some flow is going to need to be intercepted downstream of this inlet. 
 
We can see from these computations that this inlet already meets the criteria that we set for our 
roadway.   However, if this inlet had not worked we would need to consider what steps we could 
take to fix any issues that came up.  With this being the first inlet in our drainage project, the fix 
could be as simple as just establishing the rest of the system to see if it relieves the issues, but if 
the computations produced values that fell too far outside of our needs we may want to consider 
a larger inlet. 
 

 
 
 
 

 
 
Make sure you have clicked the Apply button to save your work to CB-1 before moving 
on to creating CB-2!  



Chapter 3 Inlets 

3-14 Missouri Department of Transportation 10/18/12 

3.5 Define an inlet at a sag location 
Add inlet CB-2 at the sag location.  
 
Properties Options 
 
Use the options shown below in the dialog screenshot 
 

 
 
Location Options 
 

1. Set the Align setting to Tangent to Element 
 

2. Select the MS Alignment Element button 
 

3. Data point on the rectangle that represents the roadway. 
 

Make sure AccuDraw is running 
 

4. Select the Station DP button and snap (single middle mouse click) to the lower 
right hand corner of the roadway.  Do not left-click to accept the snap! 
 

5. Select the letter O on the keyboard to set the origin. 
 

6. Move the mouse in the negative X direction, enter 18.5  
(20’ pavement width, then subtract 6” curb and ½ the grate width) 
 

7. Move the mouse in the positive Y direction, enter 1.5, and data point to accept. 
 

8. Finally select the Apply button.  
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Spread Criteria Options 
 
Enter 0.0 for the slope left & right, and 100% of the discharge approaching from the left.  
We are neglecting flow from the right hand side.  A low point will always have flow approaching 
from both sides, the right side was neglected for simplicity. 
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Elevations Options 
  
Enter the elevation as 99.5 
 
 
Discharge Options 
 
Remain the same 
 
 
Computation Options 
 
 The spread used by MoDOT for design purposes at sag inlets is not contained in the 
computations window.  You can compute the spread using simple geometry by taking the 
computed head (depth of flow in the gutter) and applying it to the spread section. 
 
Spread can be generated using the Report Builder which is not covered in this class 
.   
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Set By Pass Flow 
 
Now that we have a downstream inlet we can set it up to catch the water that isn’t collected by 
our upstream inlet.  To catch that flow, and make sure it is intercepted by the next inlet: 

• Open the previous instance, in this case, CB – 1 
• Click on the Properties Option 
• Select the ID By Pass Node tool next to By Pass to Node 
• Using the left mouse button, select the inlet downstream, in this case, CB –2 

 

  
 

• Now open the CB – 2 and look at the computations again 
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Node Placement Options 
 
Node: Properties 
  
Node ID GEOPAK will automatically number the nodes based on the order 

in which the nodes are entered. The nodes can be renumbered later 
in the design process. This is discussed in the Chapter about 
Design 
Revisions. 
 

Description (optional) This may be used to better describe the node. 
 

Node Type This will show the different node types defined in the drainage 
library. 
 

Profile The designer needs to specify the profile condition of the 
particular node to be placed. On Grade or in Sag condition. This 
affects the input and calculations for spread. 
 

Library Item Depending of the Node Type selected above, the list box will only 
show the available nodes that match the type condition. 
 

By Pass to Node The designer can specify or ID the node that will take the by 
passed discharge from the active node. 
 

Max By Pass Defines the maximum allowable by pass flow from the inlet. No 
specific computations are adjusted by this value; it is used to 
merely query the system for by pass flows which exceed this 
value. Used for On Grade Inlets only. This value could be left at 
zero (default) if no By Pass to Node is specified. 
 

Node Bottom This allows the user to specify a box size to be used along with the 
type of inlet and enables GEOPAK to assign an item for quantity 
calculations. 
MoDOT has not use this type of node in the past and currently the 
system is not yet set up to use the Node Bottom for quantity 
calculation purposes.  The new drainage library contains Node 
Bottom items that can be used if desired. 
 

Override Library Item Each node in the drainage library is associated to a pay item or 
Item ID in the Design and Computation Manager database. This 
option will override this linkage, allowing the user to select their 
own Item ID. The Department uses that option to make the placed 
node an “existing” node for quantity computations. 
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Node: Location 
 
Chain A previously defined horizontal alignment stored in the "gpk" file. 

Activate the toggle to the left of the field and select the chain from 
the list. 
 

Profile A previously defined vertical profile stored in the "gpk" file. 
Activate the toggle to the left of the field and select the desired 
profile from the list. 
 

Align: At Point When this option is utilized, the node is placed at the active angle 
in the MicroStation file at the current or dynamic Node 
coordinates. 
 

Align: Tangent to Chain When this option is utilized, the node is dynamically moved along 
the Chain, and is rotated maintaining tangency to the chain. The 
designer can enter the station location or place the node 
dynamically. 
 

Align: Tangent on 
Element 

When this option is utilized, the ID button to the right of the 
option is activated and the designer is prompted to identify and 
accept a MicroStation element. The Node is placed tangent to and 
on the identified element projected from the current or dynamic 
Node coordinates. The designer can enter the station location or 
place the node dynamically. 
 

Align: Tangent to 
Element 

When this option is utilized, the ID button to the right of the 
option is activated and the designer is prompted to identify and 
accept a MicroStation element. The Node is placed tangent to the 
identified element at the current or dynamic Node coordinates. 
 

Angle An optional angle rotation could be applied to the node. A 180-
degree angle is often needed to properly align the throat of curb 
inlets and is sometimes used in conjunction with the Mirror Node 
toggle. 
 

Station and Offset Nodes may be located by entering the station and offset in 
reference to the selected chain. If "Tangent on Element" is used, 
the offset is computed. 
 

Mirror Node When activated, the node cell is mirrored, in order that the same 
cell can be utilized to accommodate flow coming from either 
direction. 
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Offset from Gutter to 
Inlet 

Inlet hydraulic equations assume the Inlet is at the edge of the 
computed spread (i.e. the Curb). If the Inlet is offset from the 
Curb, the discharge in the spread section will bypass the Inlet. This 
value, expressed in terms of feet or meters, is used to compute this 
bypass and adjust the actual flow to the Inlet. This may be used, 
for example, when a Grate Inlet is actually set some distance away 
from the curb of the road. 
Therefore any flow calculated in that segment will not be added to 
the inlet and it will bypass to the next assigned one. 
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Node: Spread Criteria 
 
User Supplied The designer will enter the width and slopes across the spread 

section starting from the Inlet and continuing towards the edge of 
the section farthest away from the inlet. 
 

Reference TIN A spread cross section will be extracted at the inlet location from 
the TIN file defined in the Project Components item under the 
Drainage Project Preferences. The designer needs to be careful on 
what DTM is referenced since for most MoDOT projects the only 
TIN file generated is the existing ground DTM. 
 

Library Item A spread cross section will be assigned to the inlet using a Spread 
Section item defined in the Drainage Library. Once a Library Item 
has been selected, the spread source can be changed to User 
Supplied and the spread section defined by the Library Item 
modified to accommodate non-typical situations such as pavement 
width transitions. 
 

Shape A spread cross section will be extracted at the inlet location from 
the Superelevation Shapes dgn file defined in the Project 
Components item under the Drainage Project Preferences and 
shown in the Spread Criteria table. 
For curb inlets in superelevation or superlevation transition, the 
designer can use this option or enter the spread source (cross 
section) as User Supplied. 
If the superelevation shapes are not defined to the edge of 
pavement, the designer can take advantage of the toggle:”Extend 
Superelevation Shapes to Inlet at Shape Slope”, located in 
Drainage > Project > Preferences under the Inlet Options item. 
This will extend the last slope of the shape to the node location 
point defined in the structure. 
Therefore, if the shape file is used to define the spread, be aware 
that the cross section starts at the edge of pavement creating a 
theoretical section that is shifted from the actual spread section by 
the width of the gutter. This is acceptable because the calculated 
spread width is the same regardless of the shift. The gutter 
depression cannot be modeled with this approach. To account for 
the gutter depression while using the shape option, the "Shape and 
Library Item" would need to be used. 
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Shape and Library Item A spread cross section will be assigned to the inlet combining the 

section extracted from the Superelevation Shapes dgn file and 
Library item from the Drainage Library. If the gutter section is 
made a library item, this option can be used to account for the 
gutter capacity. 
To properly use this option, the superelevation shapes need to be 
defined to the edge of pavement line, and the ”Extend 
Superelevation Shapes to Inlet at Shape Slope” toggle must be off. 
 

Maximum Ponded Depth The maximum depth allowed for ponding in the cross section 
(expressed in terms of feet or meters). This does not affect any 
computations, but will produce a warning if the computed depth is 
greater. 
For sag inlets, this value is used to compute the capacity of the 
node. 
 

Maximum Ponded Width The maximum width allowed for ponding in the cross section 
(expressed in terms of feet or meters). This does not affect any 
computations, but will produce a warning if the computed depth is 
greater. 
 

Reference PGL Slope will be extracted from the profile defined in the Location 
item of the Node dialog box at the inlet location. The slope will 
update as the .gpk file is updated. 
 

User Supplied Slope will be entered by the designer in percentage format while 
omitting the % sign. 
 

Shape Slope will be extracted from the superelevation shapes dgn file 
defined in the Project Components item in the Drainage Project 
Preferences.  
For inlets in superelevation, superelevation transition, or other 
transitions, the designer can use this option or enter the 
longitudinal slope as User Supplied. 
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For an inlet in sag conditions, the approaching longitudinal slopes have no effect on the 
calculation of the inlet capacity or spread at the inlet. The spread approaching a sag inlet needs to 
be calculated and the approaching longitudinal slopes affect those calculations. The fields unique 
to Spread Criteria for Sags relate to the spread along the approaching longitudinal slopes and are 
discussed below. The designer must specify a value for Maximum Ponded depth for sag inlets. 
Although this value is not needed to compute spread, it is used by GEOPAK to compute the 
capacity of sag inlets. 
 
% Slope Left and Right For defining the longitudinal slope to use in spread (ponded width) 

computations for the flow approaching from the right and left side 
of the inlets. The terminology (right and left) is somewhat arbitrary 
as long as the designer recalls which side is intended as left and 
right. 
 

% Discharge Left and 
Right 

Defines the percentage of the total discharge to the inlet to allocate 
to the left and right approach spread computations. The 
terminology right and left are somewhat arbitrary as long as the 
designer recalls which side is intended as left and right and is 
consistent with the definition of % Slope Left and Right. 
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Node: Elevations 
 
Reference Surface Define the desired TIN File or a Model or Object within the site 

project specified in the Drainage Preferences – Project 
Components. 

Elevation Source Defines the source of the Node elevation. With the source 
specified as something other than User Supplied, the Node 
elevation will 
automatically update as the Node is moved. The options are: 
Reference Surface: Computes the actual elevation from the X 
and Y coordinates of the structure from the Location dialog 
and the Reference TIN File or Site Model. This option may be 
useful for placing Ditch Bottom Inlets at the existing ground 
elevation depicted in a TIN file. 
Reference PGL: Utilizes the Station from the Location dialog 
to ascertain the profile elevation on the Reference PGL. Note: 
This option will report the elevation directly at the station on 
the PGL. 
PGL+Spread Section: Utilizes the PGL and information from 
the Spread Criteria cross section to compute the elevation. The 
elevation is ascertained along the PGL at the specified Station 
and then adjusted along the spread cross section width and 
slope segments to the end of the cross section. Although it 
says PGL "plus" spread section, the programs subtracts 
positive values from the PGL. 

Node Elevation Options: The designer may adjust the inlet elevations up or down from the 
Elevation Source item. These options are: 
Same as Source: matches the node elevation with elevation 
source. 
Constant Offset: enables a plus or minus value to the elevation 
source selected. For example, if the reference profile is PGL+ 
Spread Section to the flow line of the gutter, a Constant Offset 
can be specified to have the node elevation be the edge of 
pavement (EOP) elevation. This is useful because the EOP is 
used for curb inlet elevations. A plus offset will add to the 
elevation value. 
User Supplied: The user may specify an elevation. 
For the outlet node elevation, the elevation is not a physical point 
on the structure. The elevation should be at least 1 foot above the 
tailwater to avoid a warning. In general, using the berm or ground 
elevation that covers the outlet structure is acceptable for the outlet 
node elevation. 

Vertical Alignment Alignment preferences for incoming and outgoing pipes from the 
Node. As pipes are designed the elevations will be set according to 
the selected preference.  
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Options available are:  
• Match Soffit: aligns all the pipes in the system by matching 
the inside top surface of each pipe. (Also referred to as the crown 
of the pipe) 
• Match Invert: aligns all the pipes in the systems by matching 
the bottom inside surface of each pipe. 
• Match Surface: aligns the pipes following the elevation of the 
water surface inside the pipes. 
• Allow Drop Manhole: allows for “drops” inside the node for 
the pipes arriving or existing the node. Not matching inverts 
or soffits will be performed. This option allows for greater 
flexibility. Since the design preference is to minimize 
excavation, the first pass during the design will align all the 
pipes at the soffit. As the designer needs to move the inverts 
of certain pipes due to various factors, e.g. utility conflicts, the 
change will only affect the selected pipe and others will 
remain at the previously set elevation. 
• Min. Fix Drop: sets a minimum drop in elevation between the 
pipes arriving and exiting the node.  

Minimum Depth Minimum depth expressed in master units (i.e., feet or meters) for 
the pipe to be buried (minimum cover) measured from the Node 
Elevation to the soffit (top inside) of the highest pipe. This value is 
used to establish the minimum cover elevation noted in the Link 
Configuration Conditions dialog box. For additional information 
see below. 

Maximum Depth Maximum depth expressed in master units (i.e., feet or meters), for 
the pipe to be buried measured from the Node Elevation to the 
invert of the lowest pipe. This value is used to establish the 
Maximum Depth elevation noted in the Link Configuration 
Conditions dialog box. For additional information see below. 

Add Sump Depth Extra depth to be allowed in the manhole structure after the 
maximum depth of the structure has been computed. This has no 
effect in the hydraulic calculations, but some designers add this 
extra depth for pollution control measures. MoDOT does not use 
this option 
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Minimum and Maximum Depth at Nodes Definition 
 
The values entered for Minimum and Maximum Depth define the vertical limits that the 
program uses to place the pipe. The Minimum Depth establishes the upper limit that pipes are 
designed in. The Maximum Depth establishes the lower limit. 
 
The minimum depth of a pipe is often established by cover. 
. 
Consider the following for the Maximum Depth: The approximate elevation of the outlet node 
should be known while designing the storm drain. The outlet elevation may be controlled by 
the minimum pipe slope or by the depth of the pond at the outlet. The designer will be able to 
lock the elevation of the outlet pipe in the Link Configurations-Conditions dialog. Locking the 
elevation of the outlet will control the total drop through the system. This will limit the 
allowable pipe envelope that the pipes are designed within. Reasonable results should 
be obtained by setting the Maximum Depth for all nodes to be deeper than the outlet pipe 
(maybe use a tentative 20' depth). Again, GEOPAK will not fully use this depth to design the 
pipes if the outlet elevation is locked. 
 
Regardless of what depths are used, the designer will still need to check for adequate depth, 
pipe slope, and hydraulic gradient clearance later in the design process. 
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Nodes: Discharge Options 
 
Use Computed Discharge Indicates using the computed discharge from a stored Drainage 

Area as the discharge to the Node. 
 

Supplied Discharge This option allows for a user supplied discharge, with disregard to 
any calculated value from a drainage area. 
 

Disable Inlet Calculations 
Capacity 

When toggled on, the designer may provide the desired inlet 
capacity overriding any GEOPAK Drainage calculated value. 
 

Link Base Flow Area / 
Link Base Flow 
Discharge 

When toggled on, an additional drainage area may be defined. The 
area can be identified graphically by clicking ID and selecting the 
MicroStation shape previously defined as a GEOPAK Drainage 
Area. 
For the Link Base Flow Discharge. the designer can also enter a 
value for the extra discharge in the proper units defined in the 
Project Preferences (cubic feet per second or cubic meters per 
second). 
This “extra” area or discharge is included in the pipe, but is not 
included in the inlet spread calculations. 
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4.1 Objectives 
Link established inlets with storm sewer pipes and create a drainage network in GEOPAK 
Drainage then design the network and view output. 

4.2 Overview 
Place an outfall approximately 100 ft to the left of inlet CB-2.  Design pipe SS-1 between inlet 
CB-1 and CB-2.  Design pipe SS-2 between inlet CB-2 and the outlet.  Assume the outfall is at 
an elevation of 99.0 ft and the HGL begins at normal depth in the pipe. 
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4.3 General Pipe Design Criteria 
 
The basic design of the pipe is controlled by the parameters set in three locations: 
 
Preferences >Link Options   
Link Profile Options -Minimize Pipe Size or Minimize Depth of Cover 
Link Design Options -Design for Full Capacity 
 
Node Configuration >Elevations >Vertical Alignment Preference  
Use Match Soffit (Top inside surface of the pipe)  
Set the Minimum Depth and Maximum Depth.  This determines the design envelope for the pipe 
design.  The preferred minimum depth of cover is 3 ft; the absolute minimum is 1 ft below the 
pavement.  EPG 750.4.2.1 
 
Link Configuration >Constraints  
As a rule of thumb use a minimum slope of 0.0103 and a minimum velocity of 3.0 ft/s.  See EPG 
750.4.2.5 for a table of minimum slopes to achieve a self-cleaning velocity when the pipe is 
flowing a quarter full. The maximum slope and velocity is up to the discretion of the designer. 
Use a minimum rise (diameter) = 1’.  This is the smallest pipe in the drainage library. 
Use a maximum rise (diameter) = 9’. This is the largest pipe in the drainage library 
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4.4 Create an Outfall 

 
 
1. Go to Component >Node >Add 

 
Name the node OUTLET 
 

2. Configure the Outlet node according to the following specifications: 
 
Properties Option 
 

Node Type:  Outlet 
Library Item:  Std Outlet 
Fix Tailwater at: Uniform Depth for this example.   
Note:  For information on establishing tailwater for storm sewers see EPG 750.4.4.1   
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Location Option 
Place the outfall approximately 100 ft to the right of CB-2, using the same approach used for 
placing inlets CB-1 and CB-2. 
 

Elevations Option 
Elevation Source:  User Supplied – 99 
 

 
 

Junction Loss 
No changes required. 
 

Discharge Options 
Select Use Computed Discharge 
 

Finally select the Apply button 
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4.5 Add Pipes to the Storm Sewer Network 

 
1. Go to  Component >Link >Add.   

The link ID should appear as SS-1. 
 

 
 
 

2. Configure SS -1 by following the information provided below: 
 

Definition Option 
Set the From Node and the To Node fields by using the drop-down lists or by using the ID option 
and selecting the nodes graphically.  
Shape:  Circular 
Material:  Concrete 
Toggle on Design Size and select any pipe from the drainage library. 

With the Design Size toggle enabled GEOPAK will run through the pipes contained in 
the drainage library starting from the smallest diameter until it finds one that will work 
for the supplied design parameters. 
You can force a pipe diameter by un-toggling Design Size and selecting a pipe from the 
drainage library. 

Number of Barrels:  1 
Check the Override Library Payitem  
This will allow for a deviation from the standard pay item number. 
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. 
 

Conditions Options 
The elevations corresponding to minimum cover and maximum depth are taken from the node 
configurations. 
Note the soffit (top inside surface of pipe) and invert (bottom inside surface of pipe) are initially 
zero. After the pipe has been designed (or if a pipe diameter had been selected under the 
definitions option) these values will be populated. 
Any two parameters can be fixed in this dialog, by selecting the toggle next to the field.  For 
example you could force the soffit at node CB-1 to an elevation of 97 and a slope of 1.5%. 
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Constraints Option 
Set the minimum and maximum rise (pipe diameter) the program should use.  The program 
will design a pipe by choosing from the drainage library between these two extremes. 
Set the minimum and maximum pipe slopes.  Select a minimum slope steep enough to 
establish a self-cleaning velocity. 
Set the minimum and maximum velocity.  Select a self-cleaning velocity for the minimum. 
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Computation Option 

 
Note there will not be any computations available until after a network has been created. 
 

3. Select the Apply button to store the pipe in the gdf file. 
 

4. Add pipe SS-2 in a similar fashion. 
 

 
 
 
 
 

4.6 Create a Network 

 
1. Go to Drainage >Network >Add menu 
 
2. Enter Example 1 for the network id 

 
3. Specify the Outlet Node as Outlet 

 
4. Select OK 
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5. Select the Build Network button 
The Build Network function checks for connectivity and establishes the flow direction 
through all of the links.  This function also validates all components for errors and 
unresolvable issues such as loops, duplicate links, no outlet, or multiple outlets. 
 

6. Select the Apply button to place the network in the GDF file. 
 

7. Select the Design button to design the network based on any design toggles that have 
been selected.  (Do not click the Apply button after choosing Design) 

 
The Analyze button will ignore any design toggles that have been selected and simply 
performs a hydraulic analysis of the network. 

 

 
 
 

Lock Sizes will lock all sizes in the network before designing 
Lock Elevations will lock all elevations in the network before designing 

 
 
 
 
 

Build Network 

Design 
Network 

Analyze  
Network 
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8. Now go to the Network drop-down menu on the Drainage menu bar and select  

Active Network 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
A drainage project can contain multiple networks and GEOPAK Drainage uses the Active 
Network feature to limit the amount of information processed by the application.  This speeds up 
performance by focusing reporting, querying, and navigation tools on the current active network.  
It is a good practice to assign the network you are working on as the active network. 
 
 
 
Note that Example1 is now displayed in the banner as the active network. 
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The computations for the pipes can now be viewed.   
 

1. Go to Component >Link >Edit 
 

 
 
 

2. Data point on either the link or text for pipe SS-1 
 
Both the conditions and computations now have values. 

 
 



  

10/18/12 Missouri Department of Transportation  

 
 

Chapter 5 

Advanced Storm Sewer 
Placement 

 
5.1 Objectives ........................................................................................................................... 1 
5.2 Overview ............................................................................................................................. 1 
5.3 Set Project Preferences ....................................................................................................... 3 
5.4 Inlet Placement using Navigator ......................................................................................... 5 
5.5 Area Placement ................................................................................................................. 12 
5.6 Pipe Placement .................................................................................................................. 28 
5.7 Network Creation .............................................................................................................. 32 
5.8 Profile/Reach Creation ...................................................................................................... 33 
 
 

  



Chapter 5 Advanced Storm Sewer Placement 

10/18/12 Missouri Department of Transportation 5-1 

5.1 Objectives 
Create and place stormwater inlets and associated drainage areas in GEOPAK Drainage 
using advanced placement options 
Use existing GEOPAK Road data in drainage design 
Create a reach and view the storm sewer profile 
 
We will be introducing a few new tools and options in this exercise including the 
Navigator feature in Drainage. 

5.2 Overview 
GEOPAK Drainage allows the use of existing GEOPAK Road data in the design of drainage 
systems.  Information such as topography, stationing and roadway cross-sections can be 
incorporated into GEOPAK Drainage, greatly simplifying the manual input of data. 
 
Using existing GEOPAK Road data, we will construct a drainage system as shown below.   
 
Simplified Plan View 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
There is a 40 ft wide bridge structure from Sta 38+00 to Sta 39+00 that we will collect runoff 
from.  From Sta 39+00 to Sta 44+48 we will be collecting runoff from centerline out to a 
distance of 75 feet. 
 
We will design for a 10-year storm in District 5. 
 

A2 

B1 B2 

MHa1 

MHb1 Out 

A B 

A1 

~100 ft ~300 ft ~248 ft 

38+00 39+00 42+00 44+48 
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Additional geometry that we will use for constructing our system is shown below: 
 
Profile View 
 

 
 
Typical Section 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 % 

20 ft 20 ft 

75 ft 75 ft 

6 % 

2.5 ft 

6 in 

Curb Opening 

4.0 ft 

7 in 

Man Hole 
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5.3 Set Project Preferences 
For this exercise we will be working with the Cole\J5EX502 project. 
 
The first few steps will involve creating the files we will be using to construct our 
drainage system and setting up the project preferences. 

 
1. Using ProjectWise, open the plan_J5EX502.dgn file from the project’s data 

folder 
 

2. Using the MicroStation File menu, choose the Save As option and save as a new 
file named drainage_J5EX502.dgn 

 
• You can use the No Wizard option when that dialog pops up, and make sure 

you save your new file to the data directory of the project (it should default to 
the correct location) 

 
• Make sure to Check-In the plan_J5EX502.dgn file when prompted 

 
 

A file has already been set up that outlines the land uses for our project area.  We simply 
need to make this file available to us by referencing it into our drainage plan. 

 
3. Access the References dialog box and attach the landuse_J5EX502.dgn file 

(located in the project data directory) using the Coincident-World orientation  
 

4. In order for Drainage to recognize the land use assignments the geometry must 
be in the active design file, so using the Merge to Master function merge the 
landuse_J5EX502.dgn file into the active file and then close the References 
dialog  

 
Now we need to set up our drainage preferences for the project.   

 
5. Follow the instructions in Chapter 1 outlined on page 5 for Beginning a New 

Drainage Project 
 

When you reach step 6 in the instructions name your drainage project 
drainage_J5EX502.gdf 

 
6. Once your project is saved then open the Preferences dialog box again so we can 

make some changes necessary to fit our project 
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7. Select the Project Components Option.  Associate job502.gpk with this 
drainage project.  The gpk file is located at T:\de-proj\Cole\J5EX502\data. 

 

  
 

Also make sure your working directory is set to \J5EX502\data in the correct 
ProjectWise location under the User Preferences 

 
8. Select the Rainfall Parameters Option and choose District 5 

 
9. Make sure the Frequency Option is set to 10 years 

 
10. Select the Node Option and change the prefix from “ CB – “ to “ A -  “ 
 
11. Click OK on the Preference dialog and choose Yes when prompted to store 

changes 
 
12. Under the Drainage Project menu options, choose the Save option  
 
This will store the changes we made to our project GDF file 
 
 
13. Zoom in on area between station 38+00 and station 45+00 
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5.4 Inlet Placement using Navigator 
One of the methods for adding components to a project is with Drainge’s Navigator.  We will be 
working with the basic operation of the Navigator throughout the rest of this exercise.   
 

1. Access the Navigator by going to Utilities >Navigator 
 

 

 
 
 
 
            Add Item 
 
            Modify Item 
 
            Delete Item 
 
            ID Item 

 

   Displays components for all networks in the Drainage file 
 

   Displays components for only the active network 
 

  Displays the drainage areas 
 

  Displays the inlets 
 

 Diplays the nodes (inlets will also be included) 
 

  Displays the links (pipes or ditches) 
 

  Displays the profiles (reaches) 
 

  Displays the culverts (not covered in this class) 
 

  Displays system routing (not covered in this class) 
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The options along the right side of the Navigator dialog allow you to: 
 
 
 

Add Item 
 
Modify Item 
 
Delete Item 
 
Identify Item 

 
 

 
2. Select the Inlet icon from Navigator and choose the Add Item icon on the right. 
 
3. The inlet should automatically be assigned the name A-1 since we set that up in the 

Preferences, so click OK to begin assigning the properties of the inlet. 
 

4. Now use the information provided for each option to construct the A-1 inlet. 
 

Instruction 4 involves using the data and screenshots contained on the following 5 pages.  
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Properties 

Node Type:  Curb 
Profile:  On Grade 
Library Item:  CURB 5 
 
Click Apply in the upper right corner 

 

 
 
 
Location 

Reference Chain:  DESIGN 
Profile:  PROPOSED 
Align:  Tangent to Chain 
Station:  42+00 
Offset:   –20 ft 
 
Click Apply 
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Spread Criteria 

Longitudinal slope:  Reference PGL 
 
Enter the provided spread section data in the input fields highlighted below and then click 
the add item icon along the right side. 
Width =  20 
Slope =  2% 
Manning’s n =  0.016 
 
Maximum Ponded Depth:  0.4  
For inlets at grade this does not enter into the hydraulic computations. It is merely used 
for querying the system.  The depth is measured at the inside of the curb face.  For a 6” 
curb a maximum allowed depth is 0.4 ft. 
 
Maximum Ponded Width (spread):  12 
This value does not enter into the hydraulic equations.  It is merely used for querying the 
system and generating a warning if the value is exceeded.   
Section 640.1.2.2 of the EPG covers Gutter Spread.  The allowable spread is based on the 
functional classification of the roadway.  The maximum allowed under any circumstances 
is 12 ft and so we will use that for our situation. 
 
Click Apply 
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Elevations 

Choose a TIN File by selecting the magnifying glass icon and selecting J5EX502.tin 
from the file listing in our data directory. 
 
Elevation Source:  PGL+Spread Section  
The program will use the PGL elevation at the specified station in conjunction with the 
spread section to compute the elevation at the inlet. 
 
Node Elevation Option:  Same as Source  
One of the options is to select constant offset.  A possible application would be if a 
profile were defined along the top of curb.  The elevation could be offset a distance of the 
curb height to achieve the inlet elevation. 
 
Vertical Alignment Preference:  Match Soffit   
Another option that could be utilized is select match surface.  Match surface will align the 
pipes based on the flow line.  
 
Minimum depth:  2.0 
Maximum depth:  15.0 
This will set the “design envelope” for your pipes. 
 
Click Apply 
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Junction Loss 

Select Defined Equations 
 

 
 

 
Discharge Options 

Select Use Computed Discharge 
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Computations 

The computations window will be empty until drainage area A -1 has been added or a 
discharge has been supplied. 

 

 
 
 
 
5. Finally click the Apply button to save the inlet to the drainage project.  Note that 

after the inlet has been added it is now contained in the navigator. 
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5.5 Area Placement 
The area corresponding to inlet A-1 can be placed in several different ways.  The first method is 
accomplished in a similar fashion as inlet A-1 was placed using the Navigator.  The second 
method utilizes the Edit Area button within the Node Configuration dialog located in the upper 
right hand corner. 
 
 

 

  

 
 
 

1. Select either of the options above to begin constructing the area 
 

2. Assign the name for your area as A-1 and click OK 
 
Now we need to draw the shape that we will use to establish our physical area boundary.  This 
shape will extend from inlet A-1 to the high point and should have a width of 75 ft measured 
from the centerline.  Utilizing GEOPAK Road tools like Draw Transition provides an efficient 
method of creating the desired shape.  

 
Select the ROAD Tools option under GEOPAK >ROAD in the Applications Pull down 
menu 
 

 
 

OR 
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Select the Draw Transition tool from the Plans Preparation set of tools 
 

 
 
 
Key in the job number 502 and select the DESIGN chain 
Begin Station:  44+48.00 
The high point is located at 44+48.   
End Station:  42+00.00 
The inlet at A –1 is located approximately at 42+00.   
Begin & End Offset:  0.0000 
For the first line, we want to trace over the top of the centerline from these two locations, 
so keying in an offset of 0 will ensure this first line will fall directly on top of the existing 
centerline. 
 
Click the Draw button 
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Now we will place the outer boundary of our shape. 
 
With the Draw Transition tool, use the same settings except make the Beginning and 
Ending Offsets -75 and click Draw 
 
Now using the Place line tool, snap to connect the endpoints of the two chains created in 
the above steps. 
 

 
 
 
Use the Create Complex Shape tool and select each of the lines and chains that will make 
up this area 
 

 
 
You can use either Manual or Automatic as the Method and you will have to Accept the 
boundary items once you have all of them selected so that MicroStation will establish the 
shape.  
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Now that we have our shape created, we can use it to define the boundary of our first 
drainage area.  We will be using the Drainage Area Definition dialog for this. 

 
3. Click the Select Shape button in the Drainage Area Definition dialog and data 

point on the drainage area and accept the selection 
   
Once the shape has been accepted the Drainage Area field should be populated.  This 
value will be in acres.  The shape that we established in the previous steps should also 
change to reflect the symbology of a GEOPAK Drainage area and should be labeled 
with the area name. 
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4. Enter the following values for the Definition option: 
Base C value:  0.6   
This is the runoff coefficient used in any portions of the drainage area that do not 
have a pre-defined land use.   
Time of Conc.:  15 
Section 749.5.3 of the EPG outlines Time of Concentration 
 

  
 

 
5. Select the Subareas option on the left of the dialog box and use the Automatic 

Delineation button to delineate the subareas based on the defined land uses   
 
Note that the sub areas will become temporarily shaded based on the corresponding 
color contained in the drainage library.   
 
If satisfied with the results select the Apply button. 
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6. Select the Computation option and then click the Compute Discharge button 
to generate intensity and discharge for the drainage area. 

 

 
 

 
7. Finally select the Apply button to place Drainage Area A-1 in the drainage 

project 
 
Note that after the area has been added the area is now contained in the navigator. 

 
 

8. Based on the data supplied in the following screenshots and information, add the 
remaining nodes and areas. 

 
Inlet A-2 
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Once you’ve completed Inlet A-2, you can create and assign Area A-2 in a similar 
manner to what we used for Area A-1 using the Draw Transition tool in GEOPAK.  
*Remember that Area A-2 contains the bridge as well as the roadway section, so there 
will be a change in the width that occurs from Sta 38+00 to Sta. 39+00. 
 
Then follow the same process for creating Areas B-1 and B-2.  The only change is that 
we will use a Tc value of 12 for these areas. 
*Area B-2 contains the bridge just like A-2 so there will be a similar offset in width. 

 
 

Inlet B-1 
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Inlet B-2 
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Once you’ve constructed your 4 inlets as outlined above, make sure you go back to A-1 
and B-1 and assign your bypass flow to the downstream inlet. 

 
Now we’ll place the manholes and the outlet for our system. 
 

Node MHa-1 
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We will use the same Spread Criteria for MHa-1 that we’ve used for the inlets.  This will 
allow us to use this data to set the Elevation Source by using the PGL + Spread Section 
option. 
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Node MHb-1 

 

 

 
 
If we use the same Elevation Source and Node Elevation options that we used for the last 
manhole you’ll notice that the elevation is higher than MHa-1.  This won’t necessarily 
create a problem since we can always adjust the elevation that the pipes enter MHb-1, but 
let’s adjust the elevation for this node anyway.  There are times when you will want to 
manually set the elevation of a node in order for your system to function properly or to 
achieve a desired outcome.  Drainage offers a couple ways this can be done, we can 
choose User Supplied and input the elevation we want to set our node at or we can tie the 
elevation to our GPK referenced data and then adjust the final elevation by using the 
Constant Offset setting under Node Elevation Options.  
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Node Out 
 

 
 
 

We are going to assume a constant normal depth of flow in the channel or stream that we 
are draining our system into, so we will use the Fix Tailwater at option and use the 
Uniform Flow setting. 
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Upon completion you should have a drainage system resembling the screenshot on the next page.   
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5.6 Pipe Placement 
Now we need to link our inlets and nodes together. 
 

1. Using the Navigator, select the Link icon at the top and then select the Add Item 
button. 

 

 
 
 
You could also use the Component drop-down menu from Drainage and choose the Link >Add 
option to place your pipe.  Another option is to launch the Drainage Main Tool Box and use the 
Link tool set. 
 
We will be using the default naming convention for our pipes, so you can click OK when 
prompted to name SS -1 for your first link. 
 
  

Select the Add Item Icon 
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2. Now use the information outlined below to configure SS -1 

 
Definition 

Description:  Pipe from A-1 to A-2 
 
Use the drop-down lists to assign the From Node and To Node 
 
Define the configuration: 
Shape:  Circular 
Material:  Concrete 
Size:  Select any pipe from the drainage library 
Enable Design Size  
Number of Barrels:  1 
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Conditions 
The soffit and invert will not be populated until after the network has been created. 

 

 
 

Constraints 
Use the design constraints listed at the start of the exercise. 
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Computations 
The network must be created before computations will be performed. 

 

 
 
 

 
3. Based on the supplied data add the remaining links. 

 
Pipe ID From Node To Node Shape Material 

SS -1 A -1 A -2 Circular Concrete 
SS -2 A -2 MHa-1 Circular Concrete 
SS -3 MHa -1 MHb -1 Circular Concrete 
SS -4 MHb -1 Out Circular Concrete 
SS -5 B -1 B -2 Circular Concrete 
SS -6 B -2 MHb -1 Circular Concrete 
 

 
The screenshot below should be used for all pipes when setting the Constraints 
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5.7 Network Creation 
Now that we have our nodes and our links established, we need to build and design our network. 
 

1. Using the Drainage menu bar go to Network and select the Add option 
 

2. Name your network Network-1 and make sure the outlet node is designated as Out 
 
Click OK 
 

3. Select the Build Network option under Validation 
Selecting the Highlight Network button will highlight your entire network to show you 
which components are recognized by GEOPAK as being part of your network 
 

4. Select the Apply button to add the network to the drainage project 
 

5. Select the Design Network option under Computations  
The Design Network process accounts for any design options that were enabled during 
the component placement process (for example: we enabled the Design Size function 
under the Configuration options when we placed our pipes) 
 

  

    
 
 

6. Now set the active network by going the Network menu on the Drainage menu bar 
and selecting the Active Network option then select Network-1 from the list of 
available networks 
 
The banner should now display Network-1 Active 

 

Build 
Network 

Design 
Network 
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5.8 Profile/Reach Creation 
Profiles are constructed in a path running in any direction (upstream or downstream) in a 
drainage Network and are utilized to visualize the network cross–section.  A profile can also be 
utilized to construct a customized profile (including groundline, pipes, depth of cover, hydraulic 
gradeline, etc. according to what display options are checked during creation) along any path.  
 
Just like most of our other components, we can use a number of different ways to add our profile.  
Adding a profile can be done by going to the Component drop-down menu on the Drainage 
menu bar or by using the Add tool from the Drainage Profile tool set.  
 

  
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 Let’s use the Navigator to add our profile. 
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1. Select the Profile option along the top of the Navigator then choose the Add button 

on the right-hand side 
 
2. Complete the Add Profile information as follows: 
 

Profile ID:  PR -1 
Description:  Profile from A-1 to Outlet 
From Node:  A1 (Select from drop-down list or use ID option to select element) 
To Node:  Out (Select from drop-down list or use ID option to select element) 
 
Click Apply 
 

 
 
 
In the Registration tab for PR-1 use these settings: 
 
Reference Surface:  TIN File  
Select J5EX502.tin (If left blank, individual Node elevations are utilized to construct 
the ground profile.) 
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3. Click the DP button in the Registration Point section and then data-point click a 

spot in your design where you want to place the profile 
 
Now before we graphically generate our profile, we will want to set up some of the different 
options and parameters. 
 
 
4. Choose the Display tab 

At this point you could enable any available option and change the colors and levels as 
necessary by double-clicking on the symbology box for that item. However, for this 
example a preference file has been created and saved in our data directory as: 
 
drg_profile_prefs.ppf 
 
Use the File >Open option in the Profile dialog and choose this file to load the 
preferences for our profile 
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5. Choose the Drainage Information tab 

This will allow you to check the items you wish to show on the profile.  Loading the 
preference file in step 5 will check certain items and give them a color and level.  You 
may still choose to show other items here. 

 

 
 

 
6. Choose the Grid & Labels tab 

This tab allows the horizontal and vertical grids to be placed in the profile along with the 
appropriate text. 
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7. Choose the Link Profile tab 

This tab displays the link configuration associated with a selected profile. You can gather 
information on elevations and even edit them in this tab.  You can select elevations or 
key them in, and change the library item currently being used from one section of your 
network to another. 

 

 
 
 

8. Finally select the Apply button to save the profile to drainage project. 
 
Take a look at the generated profile.  
 

 
 
 
Discuss options to affect the hydraulic jump. 


	Chapter01_Intro
	Chapter 1
	Introduction
	1.1  What is GEOPAK Drainage?
	1.2 Objectives
	1.3 Project Workflow
	1.4  Components
	1.5 Invoking GEOPAK Drainage
	1.6 Review Project Preferences
	Units
	Project Components
	Rainfall Parameters
	Land Use Options
	Intensity Options
	Junction Losses Options
	Inlet Options
	Node Options
	Link Options
	Profile Options
	Plan Symbology
	Updates
	Save Options

	1.7 Review Drainage Library

	Chapter02_DrainageAreas
	Chapter 2
	Drainage Areas
	2.1 Objectives
	2.2 Overview
	2.3 Basic Layout
	2.4 Define Landuses
	2.5 Define Drainage Areas

	Chapter03_Inlets
	Chapter 3
	Inlets
	3.1 Objectives
	3.2 Overview
	3.3  Define Subareas
	3.4 Define an inlet on grade
	3.5 Define an inlet at a sag location
	Set By Pass Flow


	Chapter03_Inlets-Ref
	Chapter 3
	Inlets-Reference
	3.1

	Chapter04_StormSewers
	Chapter 4
	Storm Sewers
	4.1 Objectives
	4.2 Overview
	4.3  General Pipe Design Criteria
	4.4 Create an Outfall
	4.5 Add Pipes to the Storm Sewer Network
	4.6 Create a Network

	Chapter05_AdvancedStormSewer
	Chapter 5
	Advanced Storm Sewer Placement
	5.1 Objectives
	5.2 Overview
	5.3 Set Project Preferences
	5.4 Inlet Placement using Navigator
	5.5 Area Placement
	5.6 Pipe Placement
	5.7 Network Creation
	5.8 Profile/Reach Creation


